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Abstract 

The aim of this investigation is to study the main physical, mechanical and aerodynamic properties of groundnut pods and 

kernels (Giza 5 variety) at moisture content (8.2% db). Some engineering properties, such as size, weight, percentages of the 

pod parts, repose angle, coefficient of friction, rapture force, deformation distance, projected mean area, and terminal 

velocity were measured. The 3-Dimensional linear characteristics of the samples obtained from linear measurement led to 

the conclusion that groundnut (Giza 5 variety) is oblong shape. The average length, width, thickness, geometric mean 
diameter, sphericity, surface area and aspect ratio of groundnut contains one kernel were 25.15 mm, 18.03 mm, 16.01 mm, 

19.28 mm, 77.62 %, 1176.2 mm2 ,73.16 % and hull thickness was 1.53 mm, respectively. For groundnut contains two 

kernels these characteristics were 38.62 mm, 16.17 mm, 14.91 mm, 21.23 mm, 55.38 %, 1423 mm2 ,43.82 % and hull 
thickness was 1.46 mm, respectively. While the groundnut contains three kernels were 45.63 mm, 15.71 mm, 14.57 mm, 

21.84 mm, 48.05 %, 1502 mm2 ,34.64 % and hull thickness was 1.25 mm, respectively. On the other hands, the kernels 

characteristics were 20.29 mm, 10.24 mm, 9.42 mm, 12.51 mm, 61.64 %, 491.13 mm2 and 50.47 %, respectively. The mean 
values of the weight percentages of pod parts to whole pod were 68.7 and 31.3 %, for kernels and hulls respectively. The 

average of repose angle and coefficient of friction of the groundnut pods and kernels were found to be 31.5°, 25.75°, and 

0.36, 0.47, respectively. The rapture force of groundnut pods contain two kernels was higher than rapture force of groundnut 
pods contain three kernels and one kernel at horizontal position, it was 73.82 N. While the rapture force of groundnut pods 

contain one kernel was higher than rapture force of groundnut pods contain two kernels and three kernels at vertical 

position, it was 264.87 N. The deformation distance of groundnut pods contain one kernels was less than deformation 
distance of groundnut pods contain two kernels and three kernels at horizontal position, it was 2.4 mm. While the 

deformation distance of groundnut pods at vertical position increased when the kernels increased in pods. The mean values 

of terminal velocity were found 7.8, 8.1 and 7.9 m/s, respectively for pods which contain (one, two and three kernels). 
While the mean values of terminal velocity both kernel and hull were 7.52 and 4.06 m/s. Finally, the projected area of 

groundnut pods contain three kernels was higher than projected area of groundnut pods contain three kernels and one kernel 

it was 6.54 m/s. while, the mean value of projected area for kernels 1.76 m/s. 
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1. Introduction 
 

Groundnut (Archis hypogaea L) or 

peanut is one of the important oil crops.  

It has several uses as whole seeds or is 

processed to make groundnut butter, oil, 

and other products (Putnam et al., 2013). 

It seeds contain 40–50% fat, 20–50% 

protein and 10–20% carbohydrate 

depending on the variety (Okello et al., 

2010).The determination of the physical 

and mechanical properties of groundnut 

pods play an important role in problems 

associated with design, development and 

fabrication of  harvesting, handling, 

processing (equipment or machineries), 

grading, cleaning, sorting, separation and 

packaging, sieve unit, a specific machine, 

handling, cleaning and storage 

(Mohsenin, 1980) and Alonge and 

Adigun (1999) Akcali et al. (2006) 

examined some physical properties of 

peanuts, which are effective in case of 

mobility or immobility. Firstly, the 

geometrical shape of peanuts and the 

specific mass and friction coefficient. A 

geometrical shape consisting of a 

cylinder and two hemispheres at the ends 

has found quantitative appropriateness of 

at most 91% and at least 34% for the 

varieties in Turkish standards. A 

variation of bulk density of hulled peanut 

were found 0.37–0.58 g/cm3. The solid 

densities of kernel and shell were 

determined in the range of 0.88–0.93 

g/cm3 and 0.21–0.28 g/cm3, respectively. 

The angle of repose and internal friction 

angle were measured around a 29°. The 

friction coefficient was found ranged 

from 0.23 for kernel on sheet metal up to 

0.76 for hulled peanuts on an iron grate 

perpendicular to flow. Shukla et al. 

(2019) investigated the main physical 

and mechanical properties of groundnut 

pod (GG-20 variety). Some of the 

engineering properties, such as weight, 

size, shape, angle of repose, bulk density, 

equivalent diameter, sphericity, bulk 

density, angle of repose, coefficient of 

friction and terminal velocity. The 

average length, width and thickness of 

pods were found to be 27.86 mm, 13.78 

mm and 12.06 mm, respectively. The 

average equivalent diameter was found to 

be 16.66 mm. The average sphericity was 

obtained as 0.55. The shape of groundnut 

pods comes under the category of 

oblong. The average bulk density 

groundnut pod was obtained as 0.286 

g/cm3. The average value of angle of 

repose of groundnut pod was observed as 

24°. The average coefficient of friction of 

pods was found as 0.035. Mean terminal 

velocity of pods of GG-20 variety was 

found as 10.27 m/s. Maduako and 

Hamman (2004) determined some of the 

physical properties for three varieties of 

groundnuts namely ICGV-SM-93523, 

RMP-9 and RMP-12. The angle of 

repose for the three varieties was found 

to range from 27.5–29.50 f or tire pods, 

20.3–20.80 for the seeds and 33.7–36.00 

for the shells. Coefficient of friction 

averaged 0.56 on wood and 0.41 on 

galvanized steel for the three varieties of 

groundnut pods. The moisture contents 

of the pods, seeds and shells were found 

to be 7.4%, 6.4% and 11.3% (wet basis) 

on the average respectively. The results 

also showed that groundnut pods and 

seeds were neither round nor spherical 

but may be oblong in shape. The mean 

values of the physical properties of the 

three varieties of groundnuts showed that 
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there were no significant varietal 

differences at p≤0.5 probability level. 

Tire implication of no significant varietal 

difference at p≤0.5 is that one machine 

can conveniently handle the shelling 

operation for the three varieties of 

groundnuts. Alonge and Adegbulugbe 

(2005) studied some physical properties 

of shelled and unshelled groundnuts. The 

mean values of major, minor and 

intermediate diameter (mutually 

perpendicular dimensions) were found to 

be 12.47, 7.21 and 7.78 mm for shelled 

seeds and 31.19, 10.74 and 10.80 mm for 

unshelled pods containing two to three 

seeds. The average sphericity and 

roundness were found to be 69.61% and 

54.78% for shelled seeds and 50.17% 

and 42% for unshelled pods. The mean 

bulk density, porosity, kernel density, 

volume and angle of repose were found 

to be 0.60 g/cm3, 0.46, 1.11 g/cm3, 0.36 

cm3 and 24.5 degrees respectively for 

shelled seeds and 0.21 g/cm3, 0.57 g/cm3, 

0.49 g/cm3, 1.60 cm3 and 23.3 degrees 

for unshelled pods. Aydin (2007) 

evaluated some physical properties of 

peanut fruit and kernel as functions of 

moisture content. At the moisture content 

of 4.85% d.b. the average length, 

thickness, width, geometric mean 

diameter, sphericity, unit mass and 

volume of peanut fruits were 44.53 mm, 

15.71 mm, 16.68 mm, 23.00 mm, 

51.60%, 2.16 g and 5.17 cm3, 

respectively. Corresponding values for 

kernel at the moisture content of 6.00% 

d.b. were 20.95 mm, 8.80 mm, 10.44 

mm, 12.60 mm, 57.05%, 1.063 g and 

1.14 cm3, respectively. Re-wetted 

peanuts showed that the bulk density 

decreased from 243 to 184 kg/m3, the 

true density, projected area, and terminal 

velocity increased from 424 to 545 

kg/m3, 4.88 to 6.85 cm2 and 7.25 to 7.93 

m/s, respectively as the moisture content 

increased from 4.85% to 32.00% d.b.; for 

the kernel, the corresponding values 

changed from 581 to 539 kg/m3, 989 to 

1088 kg/m3, 1.53 to 2.09 cm3 and 7.48 to 

8.06 m/s, respectively as the moisture 

content increased. The rupture strength of 

peanut and kernel decreased as moisture 

content increased. The dynamic 

coefficient of friction varied from 0.30 to 

0.73 for peanut, and from 0.22 to 0.63 for 

kernel over different structural surface as 

the moisture content increased from 

4.85% to 32.00% db. Kurt and Arioglu 

(2018) analyzed for the physical and 

mechanical characteristics of five peanut 

cultivars (NC-V11, Halisbey, Arioglu 

2003, Sultan and Osmaniye 2005) pods 

to select the most promising candidate. 

The average length, width, thickness, the 

geometric mean diameter, sphericity 

index and rupture force were studied. 

The results indicated that varied 

significant among the varieties. Shelling 

percentage values were varied between 

65.7–71.6%. The highest shelling 

percentage was obtained at NC-V11 

variety, while the lowest value was 

obtained at Sultan. The variety NC-V11, 

Halisbey, Arioglu 2003, Sultan and 

Osmaniye 2005 showed the average 

lengths of 42.27, 44.68, 46.17, 49.39 and 

44.57 mm; width of 16.00, 17.90, 17.57, 

17.45, and 17.92 mm; thickness of 17.33; 

18.68; 18.54, 18.42, and 19.10 mm, 

respectively. Rupture force and stiffness 

values of peanuts depend on the cultivars 

and varied from 191.06 to 253.19 N and 

129715.61 to 184954.67 N/m as higher 
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and lower values, respectively. The 

varieties Arioglu 2003, Halisbey and 

Sultan have lower rupture force and 

stiffness values. On the other hand, NC-

V-11 and Osmaniye-2005 varieties have 

higher value of rupture force and 

stiffness. These findings indicated that 

these two varieties need to more energy 

for hull rupture. The NC-V-11 variety 

achieved the highest values of rupture 

force than others. Some varieties had 

thick and strong hull, while some other 

had thin and weak. El-Sayed et al. (2001) 

investigated and defined the physical and 

aerodynamic properties of peanut 

(Arachis hypogaea L.) pods. The 

geometric diameter, mass, and standard 

deviation values of three peanut varieties 

(American, Chinese, and Egyptian) had 

no significant differences. The terminal 

velocity for different varieties of pods 

ranged between 7.7 to 12.9 m/s. 

Experimental measurements of shelled 

components of the Egyptian variety 

(Gisa-5) indicated that the terminal 

velocity value of 7.4 m/s was optimal for 

airflow velocity to separate shelled 

peanut components from the shells with 

only 1.8% loss of intactness and split 

seeds on a sieved surface of 6.3 and 8.0 

mm. Also importantly, air velocity values 

of 10.2 and 9.8 m/s were found adequate 

to separate the intact seeds from the split 

seeds when they are sieved on surfaces 

with meshes of 8.0 and 6.3 mm, 

respectively. Uyeri and Uguru (2018) 

investigated some compressive resistance 

(force, energy and deformation at rupture 

point) of two groundnut varieties 

(SAMNUT 10 and SAMNUT 11) kernels 

in terms of kernel sizes. The groundnut 

kernels were loaded quasi-statically in 

the axial orientation at a compressive 

loading rate of 20 mm/min, using the 

Universal Testing Machine. Results 

showed that kernel size and groundnut 

variety had significant (P≤0.05) effect on 

all the mechanical parameters studied. 

The force required for initiating the 

kernel rupture increased from 37.21 to 

76.10 N for SAMNUT 10 and 30.10 to 

64.19 N for SAMNUT 11, as the kernels 

size increased from small to large size. In 

addition, the energy absorbed by the 

kernel at rupture point increased from 

0.021 to 0.054 Nm for SAMNUT 10, and 

0.016 to 0.044 Nm for SAMNUT 11, for 

the small and large kernel sizes 

respectively. Furthermore, the results 

showed that SAMNUT 10 kernels had 

slightly higher compressive resistance 

values than the SAMNUT 11 kernels. 

Bagheri et al. (2011) measured some 

physical properties of four varieties of 

peanut (pod and kernel) at initial 

moisture content. Afterwards, the 

required force for initial rupturing of the 

peanut kernels under compression 

loading was determined as a function of 

kernel moisture content (between 7 and 

35% w.b.) and compression load 

direction. The compression load was 

applied laterally containing the suture 

line (direction 1), perpendicular to 

direction 1 (direction 2) and 

longitudinally through the hilum 

(direction 3). Results showed that Iraqi 1 

variety had the highest value of rupture 

force for both kernel and pod. Also, was 

a strongly polynomial relationship 

between rupture force and kernel 

moisture content for whole tested 

varieties. The average values of the 

rupture force at direction 2 were 61, 60, 
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64 and 57% higher than direction 3 for 

Goli, Valencia, Iraqi 1 and Iraqi 2 

varieties, respectively. Considering 

peanut kernels, the rapture force required 

to initiate rupturing was less at direction 

3 than directions 1 and 2, therefore it is 

proposed that cracking operation should 

be performed along this direction. Ince et 

al. (2009) examined the rupture 

resistance of both hulled peanut and its 

kernel in terms of average rupture force, 

deformation, firmness and toughness. 

Samples at various moisture contents and 

sizes were compressed at three loading 

positions (longitudinal, parallel to split 

plane and perpendicular to split plane). 

The compressive force needed to rupture 

for the hulled peanut and the kernel 

decreased with an increase in moisture 

content as the deformation at rupture 

point increased. Moreover, firmness 

increased, and toughness decreased when 

moisture content increased. Larger size 

hulled peanut and kernel had higher 

rupture force and firmness values. For 

toughness, the trend was opposite. The 

highest values of firmness and toughness 

were measured at perpendicular loading 

position to the split plane. The overall 

average values of rupture force, 

deformation, firmness and toughness for 

hulled peanut and kernel when the 

samples were compressed, in relation to 

the overall range of moisture content, 

size and loading position, were 

determined as 87.58 and 47.45 N, 2.16 

and 1.46 mm, 46.80 and 49.40 N/mm, 

0.018 and 0.024 mJ/ mm3, respectively. 

Kumari and Narinder (2015) reported 

that given the ease of detecting different 

dimensions of objects, such as size, 

shape, and color (RGB) analysis, digital 

image processing is increasingly being 

employed in numerous industries, 

including food processing. Image 

processing may be described in the form 

of multidimensional systems, which is a 

key characteristic. Image processing has 

become the cheapest option due to the 

development of many high-speed 

computers and signal processors. They 

added that image analysis is one of the 

best methods for measuring powder size 

distribution. And ImageJ software, which 

is freeware Java based Image Processing 

software has been used.  

 
2. Materials and methods 

2.1 Sampling 
 

Engineering and aerodynamics properties 

of groundnut pods and kernels of variety 

(Giza-5) were measured and evaluated at 

Faculty of Agricultural Engineering, Al-

Azhar University, Assuit, Egypt. 

Moisture content was 8.2 % (db). 

 

2.2 Determination of size 
 

The size of groundnut pods and kernels 

was determined in terms of length (L), 

width (W) and thickness (T). One 

hundred groundnut pods and kernels 

were taken and measured the dimensions 

L, W and T (Figure 1) with using Vernier 

Caliper with accuracy 0.05 mm. Size of 

each pod and kernels in terms of 

geometric mean diameter (Dg), surface 

area (Sa), sphericity (Φ) and aspect ratio 

(Ra) were determined by using following 

formulas (Mohsenin, 1986): 
 

Dg = (L*W*T)1/3, mm 
 

Surface area (Sa) = π(Dg)2, mm2 
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Sphericity (S) = (Dg/L)*100, % Aspect ratio (Ra) = (W/L)*100, % 

 

 
 

Figure (1): Axis and three major perpendicular dimensions of peanut. 

 
2.3 Determination of average weight of 

the groundnut pods and kernels  

A sample of 100 groundnut pods and 

kernels was selected randomly to 

determine the average weight, using a 

digital balance with the accuracy of 0.01 

g.  

 

2.4 Percentages of the pod parts 

The kernels were manually separated and 

weighed to determine the percentage of 

parts (%, by wt.) from kernels and hulls 

to pod as shown in the following 

equations: 

 
Kernels (%) = (Mass of kernel / Mass of pod) × 100 

 
Hulls (%) = (Mass of Hull / Mass of pod) × 100 

 

2.5 Angle of repose, (θ) 

This is the angle between the horizontal 

base and the inclined side of the formed 

cone due to free fall of hulls sample. The 

horizontal base of the cone (x) and its 

height (h) were measured. Three 

replicated trials were conducted for pods 

and kernels. The repose angle can be 

calculated as follows (Mohsenin, 1986):  
 

θ = tan-1(2h/x) 

 

2.6 Coefficient of friction  

The method of inclined plane apparatus 

was used to determine the coefficient of 

static friction for galvanized steel 

surface. The table gently raised and the 

angle of inclination to the horizontal at 

which the sample starts to slide was read 

off from the protractor attached to the 

apparatus. The tangent of the angle was 

reported as the coefficient of static 

friction. The following equation was 

used to calculate the coefficient of 

friction and angle of internal friction for 

the groundnut pods and kernels 

(Mohsenin, 1986): 
  
μ = tan∅  
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Where, μ = the coefficient of friction.  Ø 

= the angle of internal friction. 

 

2.7 Determination of shape of the 

groundnut pods and kernels  

The shape of groundnut pods and kernels 

was determined using the following 

formula which explained by Abd Alla et 

al. (1995). It was suggested that the value 

of index-K >1.5, then the grain is 

observed oblong, and the value of index-

K ≤ 1.5 the grain is observed spherical. 

The average values of the length, width, 

and thickness of the groundnut pods and 

kernels were placed in the next equation, 

and the values of index-K for groundnut 

pods and kernels were found to be 2.93 

and 2.07, respectively.  

 
Index-K = L/(W*T)1/2 

 

2.8 The mechanical behavior of 

groundnut pods 

It was expressed in terms of force 

required to rupture the pod sample, 

deformation at rupture point, the 

deformation ratio, the hardness and 

energy absorbed. The rupture force of 

pod sample was determined by using a 

digital universal material tester. The 

specifications of device were as follows: 

Model No: MT 20 21, range of the 

measurement is 0 to 20000 N and its 

accuracy is 0.1 N as shown in Figure (2).  

 

 
Figure (2): Universal Material Tester 

             
Rupture force (FR, N) is the minimum 

force required for crack the pit. 

Deformation (d, mm) at rupture point in 

loading direction. The used sample for 

measure the rupture force was 48 pods. 

This sample was divided to three groups 

(pod contains one kernel, pod contains 

two kernels and pod contains three 

kernels). The number of pods were 16 

pods/group. The rupture force was 

measured at two axial dimensions (length 

and width) of pods as shown in Figure 

(3). The data obtained were subjected to 

descriptive statistics such as; range 

(minimum “Min” and maximum “Max”), 

mean, standard deviation (SD) and 
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coefficient of variation (CV). 

 

2.9 Terminal velocity apparatus 
 

The terminal velocity apparatus (Figure 

4) was fabricated in the Faculty of 

Agricultural Engineering, Al-Azhar 

University, Assuit, Egypt, according to 

Saracoglu and Ozarslan (2012). A device 

consists of a vertical transparent plastic 

tube 110 cm long with a diameter of 60 

mm, which was used to suspend the 

particles in an air stream. This tube fixed 

in another rigged 60 cm long tube 

containing an air-flow straightener to 

improve air flow uniformity throw 

transparent tube. The air was supplied by 

a blower fan powered by an electric 

motor. To manage the airflow rate, speed 

of blower motor was controlled by 

electronic dimmer.  In the beginning, the 

blower output was set at minimum. For 

each experiment, a sample was dropped 

into the air stream from the top of the air 

column. Then airflow rate was gradually 

increased till the pod mass gets 

suspended in the air stream. Three digits 

were recorded in each experiment when 

the pod suspend in the vertical air stream, 

-transparent tube outlet air velocity -

distance from the bottom of transparent 

tube to flowed pod position after that the 

transparent tube removed to record inlet 

air velocity. The value of the terminal 

velocity (Tv) "m/s" was calculated using 

the following equation: 
 

Tv= Is –(Fd/Tl)*(Is-Os) 
 

Where: Tv: Air terminal velocity (m/s), 

Is: transparent tube inlet air velocity 

(m/s), Fd: distance from bottom of 

transparent tube to flowed pod position 

(cm), Tl: long of vertical transparent 

plastic tube (110 cm) and Os: transparent 

tube outlet air velocity (m/s). 

 

Five replications for each groundnut 

sample were made. Digital anemometer 

extech model AN100 with accuracy 0.01 

m/s was used to determine air velocity. 

 

  
(a) Longitudinally position. (b) Vertically position. 

 

Figure (3): The groundnut pods under universal material tester. 
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a- Apparatus. b- Pod during operation. 

 

Figure (4): The terminal velocity apparatus. 

  
2.10 Pods projected area 

The projected area of pods (contain one 

kernel, two kernels and three kernels) 

were measured by Image Analysis which 

is one of the best methods for measuring 

irregular shapes like most of agriculture 

products size. ImageJ software, which is 

freeware Java based Image Processing 

software, has been used in this paper for 

peanut pods projected area analysis. 

After take pictures to pods samples on 

dark background with Vernier caliper 

with high resolution, the file opened In 

ImageJ software, and choose the 

following steps:  

1- Analyze > Set Scale, was chosen and 

information entered to showed that 1 

pixel represents a known distance as 

shown in Figure (5). 

2- Image > Type > 8-bit, was chosen to 

convert the image to grayscale.  

3- Image > Adjust > Threshold, was 

chosen to show the Threshold dialog 

window to allows turn pods color to 

red, finally to measure the area. 

4- Analyze > Set Measurements and 

click the Area and Limit to 

Threshold checkboxes.  

5- Analyze > Measure, was chosen to 

measure the area of pods as shown 

in Figure (6). 
 

 



Hassan and Geasa / Archives of Agriculture Sciences Journal 4(3) 143–159, 2021. 

152 

 

 
Figure (5): Set Scale. Steps to represents a known distance. 

 
 

 
 

Figure (6):  Measuring area of pods in ImageJ program. 

 

 

3. Results and Discussion 

 
3.1 Physical properties of groundnut 

pods and kernels  
 

The measuring of physical properties of 

groundnut pods and kernels are given in 

Table (1). For pod contains one kernel, 

the average length, width, and thickness 

were measured as 25.15, 18.03 and 16.01 

mm. Pod contains two kernels, the 

average length, width, and thickness 

were measured as 38.62, 16.77 and 14.91 

mm. Pod contain three kernels, the 

average length, width, and thickness 

were measured as 45.63, 15.71 and 14.57 

mm respectively. The average length, 

width, and thickness of kernels were 

measured as 20.29, 10.24 and 9.42 mm 

while the average value of hull thickness 



Hassan and Geasa / Archives of Agriculture Sciences Journal 4(3) 143–159, 2021. 

153 

 

was 1.41 mm for Giza-5 variety of 

groundnuts. These measured dimensions 

will be important for designing of 

hopper, the opening of the concave, 

crushing drum, and clearance between 

drum and concave unit as described by 

Maduako and Hamman (2004). The 

mean geometric diameter, surface area, 

sphericity, and aspect ratio of groundnut 

pods contain one kernel were found to be 

19.28 mm, 1176.2 mm2, 77.62% and 

73.16% respectively. Groundnut pods 

contain two kernels the mean geometric 

diameter, surface area, sphericity, and 

aspect ratio were found to be 21.23 mm, 

1423.1 mm2, 55.38% and 43.82% 

respectively. While, the mean geometric 

diameter, surface area, sphericity, and 

aspect ratio of groundnut pods contain 

three kernels were found to be 21.84 mm, 

1502 mm2, 48.05% and 34.64% 

respectively. For kernels, the mean 

geometric diameter, surface area, 

sphericity, and aspect ratio were found to 

be 12.51 mm, 491.13 mm2, 61.64% and 

50.47% respectively. The average value 

of sphericity of kernels was observed 

higher than the pods, which means the 

sliding ability of kernels is higher than 

the pods. 

 
Table (1): Some physical properties of pods, kernels and hulls of groundnut. 

Pod contains Properties Mean Max Min SD CV 

Pod contains one kernel 

Length, mm 25.15 31.5 17.4 0.3876 0.1541 

Width, mm 18.03 26 15.2 0.3102 0.172 

Thickness, mm 16.01 17.5 14.4 0.1012 0.0632 

Dg, mm 19.28 22.257 16.452 0.1787 0.0927 

Sph, % 77.624 94.55 70.33 8.4179 0.1084 

Sa, mm2 1176.2 1555.4 849.87 2.1764 0.185 

Ra, % 73.159 111.59 59.925 16.79 0.2295 

Hull thickness, mm 1.53 2.5 1 0.4347 0.2841 

Pod contains two kernels 

Length, mm 38.62 46.8 30.6 0.4385 0.1135 

Width, mm 16.77 18.8 14.6 0.147 0.0876 

Thickness, mm 14.91 17.7 11.7 0.1819 0.122 

Dg, mm 21.234 23.416 19.033 0.161 0.0758 

Sph, % 55.383 66.228 49.909 5.2852 0.0954 

Sa, mm2 1423.1 1721.7 1137.4 2.1623 0.1519 

Ra, % 43.821 55.556 37.629 5.4959 0.1254 

Hull thickness, mm 1.46 2.3 1 0.3748 0.2567 

Pod contains three kernels 

Length, mm 45.63 52.4 38.3 0.4233 0.0928 

Width, mm 15.71 17.7 14.6 0.1006 0.064 

Thickness, mm 14.57 15.5 13.4 0.0918 0.063 

Dg, mm 21.838 23.797 19.568 0.1278 0.0585 

Sph, % 48.051 53.108 45.06 2.8876 0.0601 

Sa, mm2 1502 1778.2 1202.4 1.7451 0.1162 

Ra, % 34.643 39.454 30.247 3.2825 0.0948 

Hull thickness, mm 1.25 1.4 1 0.1716 0.1373 

Kernel only 

Length, mm 20.29 23.4 15.85 0.2514 0.1239 

Width, mm 10.24 11.7 8.7 0.0885 0.0864 

Thickness, mm 9.415 10.6 8.3 0.0758 0.0805 

Dg, mm 12.506 14.264 10.772 0.0764 0.0611 

Sph, % 61.639 60.956 51.306 6.4909 0.1053 

Sa, mm2 491.13 638.85 364.32 0.5816 0.1184 

Ra, % 50.468 50 37.179 7.9849 0.1582 

 
3.2 Average of weight of groundnut pod 

parts and its percentages 
 

The average weight of groundnut pods, 

kernels and hulls are given in Table (2).  

The average weight of groundnut pods 

contain one kernel, two kernels and three 

kernels were measured as 1.67, 2.4 and 

2.51 g, respectively. While, the average 

weights of kernels for pod contain one 

kernel, pod contain two kernels and pod 

contains three kernels were 1.19, 1.74 
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and 1.79 gm. One the other hands, the 

average weights of hulls for pod contain 

one kernel, pod contain two kernels and 

pod contains three kernels were 0.48, 

0.66 and 0.71 gm. The average weight of 

groundnut pods and kernels will be used 

to decide the size and capacity of hopper 

and crushing chamber that provide the 

stability of the machine during operation. 

While the average weight of groundnut 

hulls will be used to determinate fan 

speed for separation operation. 

 
Table (2): The average weight of pods, kernels and hulls of groundnut. 

 

Pod contains Mean Maximum Minimum SD CV 

Pod contains one kernel 

Pod 1.67 2.19 1.35 0.26034 0.15589 

Kernel 1.188 1.52 0.9 0.18624 0.15677 

Hull 0.475 0.67 0.35 0.10916 0.22982 

Pod contains two kernels 

Pod 2.401 3.28 1.74 0.47795 0.19906 

2 kernels 1.741 2.36 1.24 0.36656 0.21055 

Hull 0.661 0.9 0.49 0.13812 0.20895 

Pod contains three kernels 

Pod 2.505 3.9 1.28 0.79633 0.3179 

3 kernels 1.792 2.85 0.65 0.70222 0.39186 

Hull 0.705 1.04 0.51 0.16298 0.23117 

 
Table (3) shows the values of total 

groundnut pod parts to whole pod (%). 

Percentage of kernels and hulls ranged 

from 50.78 to 73.08 and 26.92 to 49.2% 

and the mean values were 68.7 and 

31.3%, respectively. These results may 

help for determining the mass of kernels 

in pods using the following equation: 
 

Mk = 0.687 Mp 
 

MH = 0.313 Mp 

 
Table (3): Percentages of average pod parts. 
 

Pod parts Average Maximum Minimum SD CV 

Kernels (%) 68.70 73.07 50.78 6.98 0.10 

Hulls (%) 31.29 49.21 26.92 6.98 0.22 

 
3.3 Mechanical behavior of groundnut 

pods and kernels 

 

3.3.1 Repose angle and coefficient of 

friction 

 

The repose angle average and coefficient 

of friction for pods and kernels are given 

in Table (4). The average of repose angle 

and coefficient of friction of the 

groundnut pods and kernels were found 

to be 31.5°, 25.75°, and 0.36, 0.47, 

respectively. It was observed that the 

angle of repose for groundnut pods was 

more than the kernels, and this may be 

due to the irregular and roughness 

surface of the groundnut pods. The 

conical structure of groundnut pods was 

raised by stick the pods one another, and 

it made a larger angle than kernels. The 

static coefficient of groundnut pods and 

kernels is needful in designing storage 

bins, pneumatic conveyor systems, screw 

conveyors, and threshing (Sahay and 

Singh, 2003). These measured physical 

properties of groundnut pods and kernels 

may be slightly divertive from the other 

physical properties of groundnut pods 
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and kernels explained by Muhammad et al. (2015) and Odesanya et al. (2015). 

 
Table (4): The average coefficient of friction (Φ) and repose angle (θ°) of pods and kernels. 

 

 Type  Average Maximum Minimum SD CV 

Pod 
Φ 0.36 0.38 0.35 0.011 0.0303 

θ° 31.5 34 29 1.9539 0.0621 

Kernel 
Φ 0.47 0.53 0.36 0.0717 0.1537 

θ° 25.75 28 24 1.7078 0.0663 

 
3.3.2 Rupture force and deformation distance 

 

Table (5) shows that the mean, maximum 

and minimum values of the rupture force 

and the deformation distance at 

horizontal and vertical axial dimensions 

of the groundnut pods which contains 

(one kernel, two kernels and three 

kernels). For groundnut contains one 

kernel the results showed that the rupture 

force ranged from 18.64 to 71.61 N, and 

88.29 to 264.87 N with mean value of 

43.41and 188.84 N at horizontal and 

vertical positions of groundnut pods, 

respectively. For groundnut contains two 

kernels the results showed that the 

rupture force ranged from 61.8 to 106.93 

N, and 11.77 to 76.52 N with mean value 

of 73.82 and 33.97 N at horizontal and 

vertical positions of groundnut pods, 

respectively. For groundnut contains 

three kernels the results showed that the 

rupture force ranged from 65.73 to 80.44 

N, and 10.79 to 49.05 N with mean value 

of 70.44 and 29.76 N at horizontal and 

vertical positions of groundnut pods, 

respectively. The results indicated that 

the rapture force of groundnut pods 

contain two kernels was higher than 

rapture force of groundnut pods contain 

three kernels and one kernel at horizontal 

position. While the rapture force of 

groundnut pods contain one kernel was 

higher than rapture force of groundnut 

pods contain two kernels and three 

kernels at vertical position. The 

deformation distance results for 

groundnut contains one kernel were 

ranged from 1.93 to 2.95 mm, and 2.19 

to 6.05 mm with mean value of 2.4 and 

4.45 mm at horizontal and vertical 

positions of groundnut pods, 

respectively. For groundnut contains two 

kernels the results showed that the 

deformation distance ranged from 1.49 to 

6.27 mm, and 4.25 to 6.47 mm with 

mean value of 3.25 and 5.44 mm at 

horizontal and vertical positions of 

groundnut pods, respectively. For 

groundnut contains three kernels the 

results showed that the deformation 

distance ranged from 2.49 to 5.03 mm, 

and 4.94 to 12.93 mm with mean value 

of 3.2 and 9.58 mm at horizontal and 

vertical positions of groundnut pods, 

respectively. The results indicated that 

the deformation distance of groundnut 

pods contain one kernel was less than 

deformation distance of groundnut pods 

contain two kernels and three kernels at 

horizontal position. While the 

deformation distance of groundnut pods 

at vertical position increased when the 

kernels increased in pods. 
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Table (5): Rupture force and deformation distance of groundnut pods with different loading 

orientation. 
 

Pod contains Position Maximum Minimum Mean SD CV 

One Kernel 

Horizontal 
Rupture Force, N 71.613 18.639 43.40925 22.8551 0.526503 

Deformation, mm 2.95 1.93 2.4 0.418774 0.174489 

Vertical 
Rupture Force, N 264.87 88.29 188.8425 64.59506 0.342058 

Deformation, mm 6.05 2.19 4.45375 1.537279 0.345165 

Two kernels 

Horizontal 
Rupture Force, N 106.929 61.803 73.82025 14.1263 0.191361 

Deformation, mm 6.27 1.49 3.25375 1.566351 0.481399 

Vertical 
Rupture Force, N 76.518 11.772 33.96713 20.03559 0.589852 

Deformation, mm 6.47 4.25 5.44 0.860166 0.158119 

Three kernels 

Horizontal 
Rupture Force, N 80.442 65.727 70.4358 5.902327 0.083797 

Deformation, mm 5.03 2.49 3.2 1.066349 0.333234 

Vertical 
Rupture Force, N 49.05 10.791 29.757 15.16801 0.509729 

Deformation, mm 12.93 4.94 9.578333 3.486164 0.363963 

 

 

3.4 Aerodynamic properties 

3.4.1 Terminal velocities of pods, kernels 

and hulls 

 

The terminal velocities required for 

suspending the pods, kernels and hulls 

depicted in Figure (7). The corresponding 

mean values were found to be 7.8, 8.1 

and 7.9 m/s, respectively for pods which 

contain (one, two and three kernels). 

While, the mean values of terminal 

velocity both kernel and hull were 7.52 

and 4.06 m/s. As expected, the terminal 

velocity of the hull was lower than for 

the pod and kernel. The significant 

difference between the suspension air 

velocities for the kernel and hull indicate 

that separation of these fractions by 

pneumatic means is feasible. The data on 

terminal velocity can be used in 

designing an aspiration unit. 

 

 
Figure (7): Terminal velocity of pods, kernel and hull of groundnut. 
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3.3.2 Projected areas of pods and kernels  

 

Table (6) shows that the mean, maximum 

and minimum values of the projected 

areas of the groundnut pods which 

contains (one kernel, two kernels and 

three kernels) and kernels. For groundnut 

contains one kernel the results showed 

that the projected areas ranged from 2.78 

to 4.44 cm2, with mean value of 3.59 

cm2, respectively. The results of pods 

contain two kernels showed that the 

projected areas ranged from 4.92 to 8.65 

cm2, with mean value of 6.04 cm2, 

respectively. While, pods which contain 

three kernels the results showed that the 

projected areas ranged from 4.91 to 10.13 

cm2, with mean value of 6.65 cm2, 

respectively. Furthermore, the projected 

areas of average kernels ranged from 1.4 

to 2.2 cm2, with mean value of 1.76 cm2, 

respectively. The results indicated that 

the projected area of groundnut pods 

contain three kernels was higher than 

projected area of groundnut pods contain 

three kernels and one kernel. 

 
Table (6): Projected areas of pods and kernels. 

 

Pods and kernels  Mean Minimum Maximum SD CV 

Pod contains 

One kernel 3.5918 2.874 4.439 0.47189 0.13138 

Two kernels 6.041 4.924 8.646 1.141365 0.188936 

Three kernels 6.5486 4.908 10.126 1.634364 0.249575 

Kernels 1.76 1.4 2.2 0.263312 0.149609 

 
4. Conclusion 

 
The physical, mechanical and 

aerodynamic properties of groundnut 

pods and kernels are fundamental 

parameters that provide a brief 

knowledge and useful to design the 

agriculture machine in harvesting, 

threshing, shelling, and post-harvest 

processing operation. These mechanical 

properties of groundnut pods at different 

loading orientations are important in 

designing of milling, handling, storage, 

and transportation unit. The following 

conclusions are drawn from the study of 

the some physical, mechanical and 

aerodynamic properties of groundnut 

pods and kernels (Giza 5 variety) at 

moisture content (8.2 % db): 
 

1- The average length, width, thickness, 

geometric mean diameter, 

sphericity, surface area and aspect 

ratio of groundnut pods (contains 

one, two and three kernels) and 

kernels were all investigated and 

reported. 
 

2- The results obtained indicated that the 

weight percentages of pod parts to 

whole pod were 68.7 and 31.3 %, for 

kernels and hulls respectively. 
 

3- The average of repose angle and 

coefficient of friction of the 

groundnut pods and kernels were 

found to be 31.5°, 25.75°, and 0.36, 

0.47, respectively.  
 

4- The rapture force of groundnut pods 

contain two kernels was higher than 

other groundnut pods at horizontal 

position, while the rapture force of 

groundnut pods contain one kernel 

was higher than rapture force of 
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groundnut pods contain two kernels 

and three kernels at vertical position. 
 

5- The terminal velocity was found 7.8, 

8.1 and 7.9 m/s, respectively for 

pods which contain (one, two and 

three kernels). While, the terminal 

velocity both kernel and hull were 

7.52 and 4.06 m/s. 
 

6- The projected area of groundnut pods 

contain three kernels was highest 

value. It was 4.91 cm2. While, the 

mean value of projected area for 

pods contain one kernel was 2.9 

cm2. 
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